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. Lwu y quan tron

1. Lwu y quan trong

Sé tay s dung dién t& nay danh cho moi
ngwoi dung sir dung man hinh Philips.
Hay danh thai gian doc sé tay st dung
nay trwdc khi st dung man hinh. S6 tay
bao gébm nhirng thong tin va cac lvu y
quan trong lién quan dén viéc st dung
man hinh.

Ché dd bao hanh cta Philips ap dung vOi
didu kién la san phdm phai dwoc st dung
dung céach theo muc dich st dung theo
cac hudng dan hoat ddng cung voi viéc
xuat trinh héa don goc hodc bién nhan
tlen mat gh| ré ngay mua, tén ngudl ban,
mau ma va ma s6 san xuét ctia san pham.

1.1 Lwu y an toan va bao dwéng

O cinhbao ‘

St dung cac nut didu khién, didu chinh
hoac cac quy trinh khac ngoai cac quy
trinh dwoc néu rd trong tai liéu nay co thé
khién nguoi dung dé bi dién giat, gap cac
rdi ro vé dién va/hoac co hoc.

Hay doc va thwe hién theo cac hwéng dan
sau khi két néi va str dung man hinh may
tinh:

Hoat doéng
Hay dat man hinh & khu viec khdng co
anh sang trwc tiép clia mét, anh sang
ric c6 cweng do manh va cach xa
bat ky ngudn nhiét ndo khac. Bat man
hinh 1au ngay trong moi trwdng nay cd
thé khién cho man hinh bi bac mau va
héng.

+  Di chuyén moi db vat cé thé roi vao
céac 16 théng gié ctia man hinh hoac
ngan can qua trinh lam mat thich hop
cUa cac thiét bj dién t&r bén trong man
hinh.

+ Khéng bit kin cac 16 théng gio trén vé
man hinh.

«  Dam bao d&t man hinh & gan noi co6
phich cdm va 6 cam dién.

« Néu tat man hinh bang cach rat cap
nguon hoac day dién DC, hay doi 6
giay trwéc khi cam cap nguon hoac

day dién DC dé& man hinh hoat déng
binh thuwdng.

+ Hay luén dung cap nguon chuén duwoc
cap bai PhlleS Néu thiéu cap ngudn,
hay lién hé v&i trung tam dich vu tai
dia phwong ban. (Vui long tham khéo
muc Trung tam thong tin tiéu dung
cham soéc khach hang)

« Khoéng dat man hinh & noi bi chan
dong hay va cham manh khi dang
hoat dong.

+ Khong dap hoac lam roi man hinh khi
dang hoat ddng hodc khi di chuyén.

Béo dwéng

+ D& man hinh khéng bi hong khong dé
nén qua manh Ién mat man hinh LCD.
Khi di chuy&n man hinh, hay ném chat
khung man hinh dé nhac Ién; khdng
nhac man hinh bang cach dat ban tay
hoac ngdn tay 1én mat man hinh LCD.

+ Rt phich cdm man hinh néu ban khéng
dinh st dung né trong thoi gian dai.

R0t phich cdm man hinh néu ban can
lau chui man hinh bang mot miéng
vai hoi wét. Ban cé thé lau man hinh
b&ng vai kho khi da ngat dién. Tuy
nhién, dirng bao gid dung dung mai
hlru co, chang han nhw con hodc cac
chét 16ng c6 nguén gbc tir amoniac dé
lau man hinh.

«  Pé tranh nguy co bi dién giat hoac
héng vinh vién bd man hinh, khéng
dat man hinh & noi co6 bui, mwa, nwéc
ho&c & noi qua am wot.

+ Néu man hinh bj w6t, hay lau n6 bang
vai khé cang s&m cang tot.

« Néu chét la hoac nuéc dinh vao man
hinh, hay ngat dién ngay va rut cap
nguon Sau do lau sach chét la hodc
nwée rdi glvi man hinh dén trung tam
bdo dwong.

+ Khoéng cét gir hodc str dung man hinh
& noi co hgudn nhiét, anh nang truc
tiép hodc qua lanh.

« D& duy tri hoat ddng téi wu ctia man
hinh va st dung né trong thoi gian dai,
hay diing man hinh & noi ndm trong
gi&i han nhiét dé va d6 am sau.



1. Lwu y quan trong
* Nhiét do: 0-40°C 32-95°F
+ D06 &m: 20-80% RH

+ LUV Y: Luén bat trinh bdo vé man
hinh chuyén déng khi ban khéng st
dung man hinh. Ludn bat trng dung
lam m&i man hinh dinh ky, néu khoéng,
man hinh clia ban sé hién thi nhirng
ndi dung tinh khéng thay ddi. Hién thj
lién tuc cac anh tinh trong mot thoi
gian dai co thé gay ra hién twong “anh
thtr néng”, con dwoc goi la “anh ao”
hay “anh bong ma”, trén man hinh cla
ban.
“Anh th&r néng”, “Anh d0” hay “Anh
bong ma” la hién twong phd bién trong
cong nghé man hinh LCD. Trong hau
hét cac trwdng hop, hién twong “anh
thlr ndng” hodc “anh &o” hay “anh
bdng ma” sé dan dan bién mat sau
mot thi gian man hinh bi ngat dién.

® canh bao

Cac hién twong “anh thir nong” hay “anh
a0” hay “anh bong ma” sé khong biét mat
va ban cadn mang man hinh di stra. Thiét
hai nhw trén khéng nam trong chinh sach
bdo hanh cua chung toi.

Dich vu

» Chi nhan vién dich vu chuyén mén
maoi dwoc mé vo boc man hinh.

«  Néu can moi tai lieu hwéng dan dé
stra chira hodc tich hgp man hinh,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (vui long tham khao
chwong “Trung tdm thong tin tiéu
dung”)

«  Pé biét thong tin vé viéc van chuyén,
vui ldng tham khao muc “Théng sb k§
thuat”.

+ Khéng dat man hinh trong xe hoi/cop
xe dwéi anh nang truc tiép.

& Ghicha ,

Hay tham khao y kién cta ky thuat vién
dich vu néu man hinh khéng hoat dong
binh thwéng hodc néu ban khéng chac
phai thwe hién quy trinh nao khi da lam
theo cac hwéng dan hoat déng néu trong
s6 tay nay.

1.2 M6 ta biéu twong

Cac muc phu sau day mo ta cac quy wéc
ve biéu twong dung trong tai liéu nay.

Ghi chu, Lwu y va Canh bao

Trong toan bd sé tay nay, cac doan chir
c6 thé di kém biéu twong va dwoc in dam
hodc in nghiéng. Cac doan nay bao gbm
cac ghi chu, lwu y hodc canh bao. Ching
dwoc sir dung nhw sau:

© Ghi chu

Biéu twong nay cho biét cac thong tin
quan trong va cac bi quyét gidp ban tan
dung tbt hé théng may tinh.

O Luu y

Biéu twong nay cho biét cac théng tin giap
ban biét cach tranh dwoc sw cd hdng hoc
tiém an dbi v&i phan cirng hodc mét di
lieu.

O canh bao

Biéu twong nay cho biét sy tén thwong
co thé tiém &n va gilp ban biét cach tranh
dwoc sw cb do.

Mét sb cénh bao co thé xuét hién & nhiéu
dinh dang va c6 thé khong di kém mot
biéu twong. Trong nhirng trweng hop nay,
céach thirc trinh bay cu thé cia canh bao
do6 dwoc quy dinh béi co’ quan chirc nang
lién quan.



. Lwu y quan tron

1.3 Vit bé san pham va vat liéu
dong goi

Thiét bj dién & dién t bj virt bo-WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/
sustainability/recycling,




2. Cai dat man hinh Bl L3p chan aé

1. D&t man hinh ndm sép trén bé mét
mé&m min, can than dé tranh lam tray

21 Lép dat xwédc hodac héng man hinh.
El Noi dung goi hang
Start
= 2. Gitr chan d& man hinh béng ca hai tay
T va |&p chat chan dé vao tru dé.

(1) Gan nhe chan dé vao tru dé cho
dén khi’chét cai khép chat vao
chan de.

(2) Dung ng6n tay van chat dinh vit
nam & phia dwéi chan dé va siét
chét chan dé vao tru dé.

DVI (tay chon)

VGA (tuy chon)




2. Cai dat man hin

El Két néi véi PC

PHILIPS

O biu vao ngudn dien AC
© bau vao VGA

DBau vao DVI-D (c6 s&n cho mau vira
chon)
Khéa chéng trdom Kensington

Két néi véi PC

1.

Cam chét cap ngudn vao mat sau cla
man hinh.

2. Té&t may tinh va rat cap ngudn.

Cam cap tin hiéu man hinh vao 16 cdm
video & mat sau may tinh.

Cém cap ngudn clia may tinh va cap
nguc“)n clia man hinh vao 6 cam dién
gan do.

Bat may tinh va man hinh. Néu man
hinh hién thi hjnh anh thi qua trinh cai
dat da hoan tat.

2.2 Str dung man hinh

El Mb ta mat trwdec cua san pham
190E3L:

@/v /A /4 /0K [0)

190E3L (cho mau 1A):

/v /A 0/« /0K [0)

—_—
—

BAT va TAT ngudn man
hinh.

&) /0K |Truy nhap menu OSD.

4 |Tréd vé mirc OSD truwdec.

@ |Pbi dinh dang hién th.

O-  |Chinh d6 sang.

A V¥V |Chinh menu OSD.

© |Pbingudn vao tin hiéu.

© 6 6 00 o

€ [Péi dinh dang hién thj.

Smartlmage Lite. C6 ba

ché dd dé ban lwa chon:
o @ Standard (Chuén), Internet
va Game.




2. Cai dat man hinh
El Mb ta menu Hién thj trén man hinh

Hién thi trén man hinh (OSD) la gi?
Hién thi trén man hinh (OSD) la mét tinh
nang cé & moi man hinh LCD cta Philips.
N6 cho phép ngudi dung didu chinh hoat
dong ctia man hinh hodc chon cac chirc
néng ctia man hinh tryc tiép théng qua
mot clra s& hwéng dan hién thi trén man
hinh. M6t giao dién hién thj trén man hinh
dé st dung dwoc thé hién nhw sau:

190E3L:

Hwéng dan co ban va don gian vé cac
nut diéu khién

Trong menu OSD minh hoa & trén, ban cé

thé nhan ¥ A cac nat & g& mat trwdc cla
man hinh dé di chuyén con tré va nhan
nat OK dé xac nhan lwa chon hodc thay
déi.

VGA
— Input I:

Menu OSD

Dwai day la tdng quan vé& co ciu cla
menu Hién thi trén man hinh. Ban co thé
st dung co' c&u nay lam thong tin tham
khao khi muén thuc hién cac diéu chinh
khac sau nay.

Main menu Sub menu

DVI (available for selected model)

— Picture Format —  Wide Screen, 4:3
— Picture
— Brightness — 0~100
— Contrast — 0~100
“— SmartContrast — On, Off
— Color Temperature — 6500K, 9300K
— Color
— sRGB
— User Define Red: 0~100
E Green: 0~100
Blue: 0~100
— Language — English , Espafiol, Francais, Deutsch, Italiano,

Portugués, Pycckuin, A3, Tirkge

— Horizontal — 0~100
— OSD Settings
— Vertical — 0~100
—— Transparency — Off,1,2,3,4
— OSD Time Out — 55, 10s, 20s, 30s, 60s
L— Setup — Auto
—— Power LED — 0,1,2,3,4
— H. Position — 0~100
— V. Position — 0~100
[ Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes, No
L— Information




El Théng bao vé dé phan giai

Man hinh nay dwoc thiét ké d& hoat déng
tdi wu v&i d6 phan gidi gbc 1a 1440 x 900
@ 60 Hz. Khi dwgc chinh sang dd phan
giadi khac, man hinh sé hién thi mot thong
bao: Dung 1440 x 900 @ 60 Hz dé dat két
qua tbt nhét.

Ban co thé tat thong bao hién thi d6 phan
gidi goc tir muc Setup (Cai dat) trong
menu OSD (Hién thi trén man hinh).

El Tinh nang vat ly
Nghiéng

2.3 Thao dé va chan dé

E Thao chan dgé

Trwéc khi bat dau thao chan dé man

hinh, hay thwc hién theo cac hwéng dan

bén dwi dé tranh moi thiét hai hay chan

thwong cé thé xay ra.

1. Dat man hinh ndm sip trén bé mat
min, c&n than dé tranh lam tray xwéc
hodc héng man hinh.

2. Thao chan dé ra khdi tru dé bang
cach:

(1) Dung ngdn tay n&i Idng dinh vit
nam & phia duéi chan dé.

(2) Chuyén nhe I&n xu6ng dé nha chét
cai khoa chan dé va kéo chan dé
ra khai tru dé.




2. Cai dat man hinh

H Thao d@é

1. Ban c6 thé& str dung tua vit dau det dé
&n vao hai khép nha trén nép ban 1&
va cay nhe ndp ban 1& dé thao no ra.

2. Thao 4 dinh vit rdi thao chan dé ra
khéi man hinh.




3. T6i wu hda hinh anh

3.1 Smartimage Lite

E pélagi?

Smartlmage Lite cung c&p cac chirc nang
cai dat s&n gilp ban t6i wu hoa man hinh
d& str dung cho cac kiéu ndi dung khac
nhau, linh hoat chinh d6 sang, dé twong
phan, mau sic va do sic nét khi st dung
thwe té. DU lam viéc voi cac trng dung
bang chi, hién thi hinh anh hay xem
video, Philips Smartimage Lite cling mang
lai cho ban hiéu qua man hinh t&i wu nhét.
Bl sao t6i phai can n6?

Ban mudn mdt man hinh hién thj téi wu
moi kiéu noéi dung wa thich, phdn mém
Smartimage Lite sé linh hoat chinh do
sang, do twong phan, mau séc va do sac
nét khi st dung thwc t& nhdm nang cao
trai nghiém xem man hinh cda ban.

El cach hoat dong?

Smartlmage Lite la céng nghé dac quyén
tién tién cta Philips vén sé& phan tich cac
ndi dung hién thj trém man hinh cta ban.
Dwa trén bdi canh st dung ma ban lva
chon, Smartimage Lite sé linh hoat cai tién
do twong phan, bdo hoa mau sac va do
s&c nét clia hinh anh d& cai thién ndi dung
dang hién thj - tit ca khi s& dung thuc té
chi v&i duy nhat mét ci nhan nat.

El Cach bat chirc nang Smartimage Lite?

1. Nhén BD §é khai dong Smartimage
Lite trén man hinh;

2. Tiép tuc nhan BD dé chuyén giva
Standard (Chuén), Internet, Game.

3. Menu OSD Smartimage Lite s& van
hién thi trén man hinh trong 5 giay
ho&c ban ciing c6 thé nhan OK dé xac
nhan lwa chon.

4. Khi Smartimage Lite da duoc bat, bd
cuc sRGB sé tw dong tat. Dé dung
sRGB, ban phai t&t Smartimage Lite
bang nut B & go mét trwdc clia man
hinh.

Néu khong diing nat B @& cuon xuéng,

ban ciing c6 th& nhan cac nut v A dé& chon

va nhan nut OK d& xac nhan lwa chon va
dong menu OSD Smartimage Lite.

C6 ba ché do dé ban Iwa chon: Standard

(Chuan), Internet va Game.

@ SmartImage '™

Standard

Internet

« Standard (Chuén): Lam r6 chir va
gidm d6 sang gitp ban dé doc chir va
b&t méi mat. Ché d6 nay téng dang ké
s rd rang clia ndi dung chir va hiéu
suét khi ban Iam viéc v6&i cac bang
tinh, file PDF, cac bai muc scan hoac
cac tng dung van phong khac noi
chung.

e Internet: CAu hinh nay két hop bao
hda mau séc, linh hoat téng dé twong
phan va séc nét dé hién thi anh chup
va cac hinh anh khac vé&i d6 rd ndi bat
cung mau séc séng dong - tat cd moi
the ma khong hé co6 déu vét cia mau
sac nhat va gia tao.

« Game: Tang mach truyén dong dé co
thoi gian dap (ng téi wu, giam cac
b& 1& gai géc cho cac dbi twong di
chuyén nhanh trén man hinh, tdng dé
twong phan cho b cuc sang va tdi,
cau hinh nay mang lai cho ngwdi choi
trai nghiém choi game tét nhét.




3.2 SmartContrast

H polagi?

Coéng nghé doc dao vén linh hoat phan
tich ndi dung hién thi va tw déng téi wu
hoéa ty Ié twong phan ctiia man hinh LCD
dé mang lai d6 rd nét va trai nghiém xem
tdi wu, tang mirc dén nén dé hién thi
nhirng hinh anh sang ré hon, sic nét hon
va sbng dong hon hay gidam mac dén nén
@& hién thi rd hinh anh trén phéng nén tbi.
E Sao t6i phai can n6?

Ban muén hién thi n6i dung ré nét ciing
cam giac thoai mai nhat khi xem moi loai
ndi dung. SmartContrast sé linh hoat chinh
d6 twong phan va mirc dén nén dé hién
thi nhirng hinh anh choi game hay video
cwe rd, sbng déng va sac nét hay hién thi
ndi dung chir rd rang dé doc cho céac trng
dung van phong. Bang cach gidm viéc tiéu
thu dién ctia man hinh, ban sé tiét kiém
dwoc chi phi nang lvong va kéo dai tudi
tho cho man hinh ctia ban.

El cach hoat dong?

Khi ban bat ché d& SmartContrast, n6 sé
phan tich néi dung dang hién thj trong
thwe té dé chinh mau sac va mat do den
nén. Chirc ndng nay sé linh hoat téng
do twong phan d& mang lai cho ban trai
nghiém gidi tri tuyét voi khi xem video
hodc choi game.

3.3 Philips SmartControl Lite

Phan mém SmartControl Lite méi cuia
Phillips cho phép ban diéu khién man hinh
qua giao dién do hoa o tién dung. Cac
didu chinh phtc tap la nhirng gi thudc

vé qua kh(r vi phan mém than thién voi
ngudi dung nay sé huéng dan ban qua
viéc tuy chinh d6 phan giai, hiéu chinh
mau, didu chinh ddng hé/géc pha, diéu
chinh diém trang RGB (D6é-Luc-Lam), v.v...

Trang bi cdng nghé méi nhat vé thuat toan
I6i xt Iy va phan &ng nhanh, phan mém
chay bdng anh déng bt mét thwong thich
v&i Windows 7 nay sén sang nang cao trai
nghiém cua ban v&i man hinh Philips!

10

H cai dat

Thuwe hién theo chi dan va hoan tat quy
trinh cai dat.

Ban c6 thé khéi dong phan mém sau
khi hoan tat cai dat.

Néu muén khéi dong sau, ban co thé
click phim tat phdn mém trén man hinh
nén hodc thanh céng cu may tinh.

PHILIPS s g e aizzire

Wizard (Thuat si) kh&i dong lan dau

khong can thuat si.

Lan dau khi cai dat phan mém
SmartControl Lite, n6 sé tw dong vao
Wizard (Thuat si) khéi déng lan dau.
Thuat sT nay s& hwéng dan ban théng
qua viéc diéu chinh tirng buéc vé hiéu
suat man hinh.

Sau nay ban ciing c6 thé vao menu
Plug-in (Bé sung) dé bat thuat si.

Ban c6 thé chinh cac tly chon khac
qua giao dién Standard (Chuan) ma

X
SmartControl Lite PHILIPS

‘‘‘‘‘



3. T6i wu héa hinh anh

E Khéi dong bing giao dién Chuan:

Menu Adjust (Diéu chinh):

+  Menu Adjust (Biéu chinh) cho phép
ban chinh Brightness (D6 sang),
Contrast (B¢ twong phan), Focus
(Trong tam), Position (Vi tri) va
Resolution (D6 phan giai).

« Ban c6 thé 1am theo chi dan va thuc
hién diéu chinh.

* Lénh Cancel (Hly) sé hdi nguwdi dung
xem ho c6 mudn hay tién trinh cai dat
hay khong.
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SmartControl Lite
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3. T6i wu héa hinh anh

Menu Color (Mau):

Menu Color (Mau) cho phép ban chinh
mau RGB (Dé-Luc-Lam), Black Level
(D6 tbi), White Point (Diém trang),
Color Calibration (Hiéu chinh mau).
Ban co thé 1am theo chi dén va thuc
hién diéu chinh.

Tham thao bang bén dudi dé hinh
dung co ban vé muc menu phu trén
théng tin nhap cua ban.

Vidu Qolor Calibration (Hiéu chinh
mau sac):

[ x|

: SmartControl 1t PHILIPS

Black Level

a
olEm=

— Vet
& = =
el
| ] smwracartrat Loe 1 :
SmartControl 1t PHILIPS |

& & |
£
@

‘White Point

Coepin

ap

st 1|
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SmartControl 1€ PHILIPS i

Calibration
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sl

[

gt

o

1. "Show Me” (Cho t6i xem) sé& bat
hwéng dan hiéu chinh mau.

2. Start (B4t dau) - bat dau quy trinh
canh chinh mau qua 6 bwéc.

3. Quick View (Xem nhanh) tai cac hinh
anh trwéc/sau.

4. Tré vé& giao dién chinh Color (Mau),
click nat Cancel (Huy).

5. Enable color calibration (Bat hiéu
chinh mau) - theo méc dinh la dugc
bat. Neu khéng chon muc nay, ban
khong dwoc phép hiéu chinh mau va
tat cac nat khéi dong va xem nhanh.

6. Phai c6 théng tin bdng sang ché trén
man hinh hiéu chinh.

Man hinh hiéu chinh mau dau tién:

+ Nut Previous (Trwéc) sé tat cho dén
khi man hinh mau th hai bat 1én.

*  Next (Ké tiép) s& chuyén vao muc tiéu

tiep theo (6 muc tiéu).

«  Cubi cung, vao giao dién File>Presets

(File>Cai sén).



+ Nut Cancel (Hay) sé dong giao dién

nguwoi dung (Ul) va tré vé trang bd sung.

Smartimage Lite
Cho phép nguoi dung thay doi cai dat dé
dat mirc cai dat man hinh tot hon dwa vao
néi dung.
Khi da cai dat Entertainment (Giai tri), tinh
néng SmartContrast va SmartResponse
sé tat.

T

SmartControl Lite PHILIPS
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Options>Preferences (Tuy chon>Uu
tién) - Sé chi hoat dong khi chon
Preferences (U’u tien) tr menu Options
(Tuy chon) s6 xudng. Trén man hinh
khéng ho tro twong thich voi chuan DDC/
Cl, chi c6 san cac thé Help (Tro gidp) va
Options (Tuy chon).

1
PHILIPS

i [
SmartControl ¢
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* Hién thj cac cai dat wu tién hién hanh.
« O vira chon sé& bat tinh nang nay. O
chon 1a nat bat/tat.

Enable Context Menu (Menu bat thuéc
tinh) trén man hinh nén PC sé dwoc
chon la (Bat) theo mac dinh. Enable
Context Menu (Menu béat thudc tinh)
hién thi cac lwa chon SmartControl
Lite cho Select Preset (Chon cai san)
va Tune Display (Chinh man hinh)
trong menu thudc tinh khi click phai
vao man hinh nén. Disabled (D3 tat)
sé x6a SmartControl Lite khéi menu
thudc tinh click phai.

« Bidu twong Enable Task Tray (Bat
khay tac vu) dwoc chon la (Bét) theo
mac dinh. Menu bat thudc tinh hién thi
menu khay tac vu cho SmartControl
Lite. Click phai vao biéu twong khay
tac vu sé hién thi cac tuy chon menu
cho Help (Trg gitp), Technical Support
(Ho tro ky thuat) Check for Update
(Kiém tra cap nhat), About (V&) va Exit
(Thoat). Khi da tat Enable task tray
menu (Menu bat khay tac vu), biéu
twong khay tac vu sé chi hién thi EXIT
(THOAT).

* Theo mac dinh Run at Startup (Chay
khi khéi dong) sé dwoc chon 1a (BAT).
Khi d& tat, SmartControl Lite s& khong
bat khi kh&i dong hoac nam trong
khay tac vu. Cach duy nhéat de bat
SmartControl Lite la tiv phim tat trén
man hinh nén hodc tw file chwon
trinh. B4t ky bo cai d&t sdn nao dé
chay khi kh&i dong sé hoat déng
khong tai khi 6 nay khéng dwoc chon
(ba tat).

+ Enable transparency mode (Béat ché
do trong suodt) (Windows 7, Vista, XP).
Mac dinh 1a 0% Mo

Options>Input (Tuy chon>Nhap) - Sé

chi hoat déng khi chon Input (Nhap) tie

menu Options (Tuy chon) sé xudng. Trén
man hinh khéng ho tro tucyng thich vé&i
chuén DDCI/CI, chi c6 sén cac thé Help

(Trgr giap) va Options (Tuy chon). Tatca

cac thé SmartControl Lite khac déu khéng

co san.



. T6i wu héa hinh anh
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+  Hién thj giao dién hwéng dan Source
(Nguon) va cai dat ngudn nhap théng
tin hién hanh.

e Trén cac man hinh nhap riéng, giao
dién nay s& khong hién thi.

Options>Audio (Tuy chon>Am thanh)

- S& chi hoat déng khi chon Audio (Am

thanh) t& menu Options (Tuy chon) s

xudng.

Trén man hinh khéng hé tro  tvong thich

v&i chuén DDCI/CI, chi c6 s8n cac thé

Help (Tro’ giup) va Options (Tuy chon).

._y.,—, Tx

SmartControl Lite PHILIPS

Adunt

=
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Help>User Manual (Tre’ gitip>Sé tay st
dung) - S& chi hoat dong khi chon User
Manual (S tay str dung) tr menu Help
(Tro gitip) s6 xudng. Trén man hinh khéng
hé tro twong thich véi chudn DDC/CI, chi
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c6 s8n cac thé Help (Tro giup) va Options
(Tay chon).

T T
SmartControl Lite PHILIPS

User Manu,

=
= 1.
. 4
]
]
e

Help>Version (Tr¢’ giup>Phién ban) - Sé
chi hoat déng khi chon Version (Phién
bén) tr menu Help (Tro gilp) s6 xudng.
Trén man hinh khéng hé tro! twong thich
v&i chudn DDC/CI, chi cé san cac thé
Help (Trg gitp) va Options (Tuy chon).
p—— 7=

SmartControl Lite PHILIPS

Version

iRelnjem

4
-/

Menu nhay cam vé&i thudc tinh

Theo mac dinh, Context Sensitive Menu
(Chinh theo thudc tinh) sé dwgc Bat. Néu
da chon Enable Context Menu (Bat thuéc
tinh) trong giao dién Optlons>Preferences
(Tuy chon>Wu tién) thi menu nay sé hién
thi.



. T6i wu héa hinh anh

D SmartControl
Belect Preset L2
Tune Display

Menu thudc tinh cé b6n muc nhap:

SmartControl Lite - khi d& chon, About
Screen (V& man hinh) sé hién th|

Select Preset (Chon cai dat san)
Cung cép menu cac muc cai sén da
Iwu theo trinh tw dé st dung ngay.
DAu kiém sé& hién thj muc cai san hién
da chon. Muc Factory Preset (Cai sén
goc) cung c6 thé duwoc chon tlr menu
sO xudng.

Tune Display (Chinh man minh) - M&
bang diéu khién SmartControl Lite.
Smartimage Lite - Kiém tra cac cai dat
hién hanh, Standard (Chuan), Internet,
Game.

ba bat menu khay tac vu

Ban co thé hién thi menu khay tac vu
béng cach click phai vao biéu twong
SmartControl Lite ttr khay tac vu. Click trai

sé€ bat rng dung.

Help

Technical Support
Check for Update
About

Exik

Khay tac vu c6 nam muc nhép:

Help (Trcy giup) - Truy cap file User
Manual (SO tay st dung): M& file User
Manual (S tay st dung) qua ctra sé
trinh duyét mac dinh.

Technical Support (H6 tro’ ky thuat) -
hién thi trang ho tro ky thuét.

Check for Update (Kiém tra cap nhat)
- dan ngwoi dung dén Nén trng dung

PDI va kiém tra phién ban cta nguoi
dung so v&i phién ban co s&n méi nhét.

*  About (Ve) Hién thi thong tin tham
khao chi tlet phién ban san pham
thong tin vé phién ban va tén san
pham.

» Exit (Thoat) - Bong SmartControl Lite.

D& chay lai SmartControl Lite, hay chon
SmartControl Lite tir menu Program
(Chwong trinh), click déi biéu twgng PC
trén man hinh nén hodc kh&i dong lai hé
thong.

PHILIPS

SmartControl

2010 MMD
Por wasdhyD isplay Tune(R)

Al Rights

Copyright o vs uppliers Acknowledged

P4 tat menu khay tac vu

Khi da t&t Khay tac vu trong thu muc

wu tién, chi con cé sén lwa chon EXIT
(THOAT). Bé x6a hoan toan SmartControl
Lite khoi khay tac vy, hay tat Run at
Startup (Chay khi kh&i dong) trong
Options>Preferences (Tuy chon>Uu tién).



4. Cac thong soé ky thuat

4. Cac thong sé ky thuat

Loai mat man hinh TFT-LCD

Pén nén LED

C& man hinh 19" W (48,26cm)

Hé s6 co 16:10

Do pixel 0,2835 x 0,2835 mm
Do sang 250 cd/m?

Do twong phan théng minh | 20.000.000:1

Do twong phan (chuan) 1000:1

Thoi gian dap tng (chuan) | 5ms

D6 phan giai toi wu

1440 x 900 @ 60Hz

Gobc xem

170° (H) / 160° (V) @ C/R > 10

Cai tién hinh anh

Smartlmage Lite

Mau man hinh

16,7 triéu mau

Téc do phat doc

56Hz - 76Hz

Tan sb ngang

30kHz - 83kHz

sRGB (Dd-Luc-Lam chuén)

Dau vao tin hiéu

coO

DVI (KTS), VGA (Analog),

Tin hiéu vao

Tién ich cho ngu®i dung

DPong bo riéng, Pdng bd véi tin hiéu xanh luc

190E3L:  &/v
190E3L(1A): E/v

/A
/A

/4
0/ 4

/0K 0)
/0K [0)

Ngén ngi OSD (Hién thi
trén man hinh)

Tiéng Anh, Tiéng Phap, Tiéng Dirc, Tiéng Tay Ban Nha,
Tiéng Y, Tiéng Nga, Tiéng Hoa gian thé, Tiéng B6 Pao
Nha, Tiéng Thé Nhi Ky

Tién ich khac

Khoéa Kensington

Twong thich véi chuén Plug
& Play (C&m vao Ia phat)

Nghiéng

DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

-5/+20

Ché db bat

17,77W(chuén), 18,98W(t6i da)

Tiét kiém nang lwong
(Phwong phap thtr nghiém
EnergyStar 5.0)

Dién ap dau vao
AC v@i cdng suat
100VAC +/-5VAC,

Dién ap dau vao
AC véi cong suat
115VAC +/-5VAC,

Dién ap dau vao
AC v@i cong suat
230VAC +/-5VAC,

100VAC +/-5VAC,
50Hz +/- 3Hz

115VAC +/-5VAC,
60Hz +/- 3Hz

50Hz +/- 3Hz 60Hz +/- 3Hz 50Hz +/- 3Hz
Hoat dong théng thuong (chudn) | 14,5W 14,4W 14,37W
Ngu 0,5W 0,5W 0,5W
Téat 0,5W 0,5W 0,5W

Dién ap dau vao | Dién ap dauvao | Dién ap dau vao
Tan nhist* AC v@icong suat | AC voicodng suat | AC voi cong suat

230VAC +/-5VAC,
50Hz +/- 3Hz

16




4. Cac thong soé ky thuat

Hoat dong thong thudng 49,49 BTU/gio 49,15 BTU/gioy 49,04 BTU/gio
Ngu 1,71 BTU/gioy 1,71 BTU/gi& 1,71 BTU/gi&
Tét 1,71 BTU/gior 1,71 BTU/gioy 1,71 BTU/gioy
DPén bao LED ngudn Ché d6 bat: Ché do Trang, Chd/Ngu: Trang (nhap nhay)
B6 nguE“)n Thtr nong, 100-240VAC, 50-60Hz

San pham kém theo dé gite
(Réng x cao x day)

463,59 x 390,93 x 199,8 mm

San pham khéng kém theo

463,59 x 320,46 x 41,1 mm

(Khéng hoat déng)

dé gitr (Rong x cao x day)

San phdm kém theo dé gitr | 3,19kg

S?n .eham khéng kem theo 2,8kg

de gitv

San pham déng goi 4,45kg
Pham vi nhiét d6 (hoat dong) | 0°C - 40 °C
Gi®i han nhiét do 20°C - 60°C

Do am twong déi

20% - 80%

b6 cao

Hoat déng: + 365.760,00cm (3.658m)
Khéng hoat dong: + 1.219.200,00cm (12.192m)

MTBF (Thoi lwong trung
binh gitra cac sw cd)

30.000 gior

Chi thi ROHS (Gi¢i han cac

chét gay hai) co

EPEAT DAu Bac (www.epeat.net)

Thung dwng C6 thé tai ché 100%

Phé chuan theo quv dinh CE Mark, FCC Class B, GOST, SEMKO, TCO Certified,
ay d UL/cUL, BSMI, 1S09241-307

Mau Ben (Phia sau), Xanh (Phia trwéc)

L&p son ngoai

Bong loang

& Ghi cha

1. D&u Vang hay DAu Bac EPEAT chi c6 hiéu luc tai noi ma Philips da déng ky san pham.
Hay truy cap www.epeat.net dé biét tinh trang déng ky tai quéc gia clia ban.

2. D@ liéu nay chiu sy thay d6i ma khong can thong bao trude. Truy cap www.philips.com/
support dé tai vé phién ban t& roi méi nhét.
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4. Cac thong soé ky thuat

4.1 Ché do do phan giai & cai
dat san
E D6 phan giai t6i da
1440 x 900 @ 60 Hz (d4au vao analog)
1440 x 900 @ 60 Hz (d4u vao KTS)

E D6 phan giai khuyén diing
1440 x 900 @ 60 Hz (d4u vao KTS)

480i |720 x 480 SD |60

480p |720 x 480 SD |60

576i |720 x 576 SD |50

576p (720 x 576 SD |50

720p (1280 x 720 | HD |50, 60

1080i {1920 x 1080 | HD |50, 60

1080p (1920 x 1080 | HD {50, 60

& Ghicha

Lwu y r&ng man hinh cta ban hoat déng
tbt nhat & do phan giai gbc 1440 x 900 @
60Hz. D& co6 chét lwong hién thi tot nhét,
hay dung d6 phan giai khuyén nghi nay.

18



5/ Quan ly ngudn dién

5. Quan ly nguén dién

Néu ban da cai dt card man hinh hay
phan mém twong thich chudn VESA DPM
vao PC, man hinh c6 thé tw dong giam
tiéu thu dién khi khéng st dung. Néu phat
hién nhap tlr ban phim, chudt hay thiét bi
nhap khac, man hinh sé “hoat dong” tw
dong. Bang sau day sé hién thi mie tiéu
thu dién va cach truyén tin hiéu cla tinh
nang tiét kiém dién tw déng nay:

ChE 66 | \i4e0 ngg Dbéng | Ngudn dién str | Mau dén
VESA nga'ng b6 doc dung LED
" . . <17,77 W <
Hoat dong| BAT | Co Co @ Trang
' Tréng
Ngu TAT [Khéng|Khéng|<0,5W (chuén) | (Nhap
nhay)
Tét TAT - - | <0,5W (chudn)| TAT

Cai d&t sau day dwoc dung dé do mirc
tiéu thu dién trén man hinh.

« Do phan giai gbc: 1440 x 900

+ Do twong phan: 50%

+ D06 sang: 250 nit

+ Nhiét d6 mau: 6500k véi kiéu mau
trang day du

& Ghi cha

Dt liéu nay chiu sw thay ddi ma khong
can théng bao truéc.
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6. Thong tin quy dinh

6. Théng tin quy dinh

Lead-free Product

Lead free display promotes
environmentally sound recovery
 and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!
This display is designed for both you and the

planet
carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a high
performance product, designed with the user
in focus that also minimizes the impact on the
climate and our natural environment.

The display you have just purchased

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the
TCO Certified for displays:

*  Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

20

* Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of
the TCO Certified for displays:

*  The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or 1SO 14001).

*  Very low energy consumption both in on-
and standby mode minimize climate impact.

e Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is
now requested by users and [T-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document,Ver. 2.1

I[n Technology for you and the planet
CERTIFIED



6. Thong tin quy dinh

EPEAT

(www.epeat.net)
@, 'The EPEAT (Electronic

Product Environmental

N Assessment Tool) program
evaluates computer

desktops, laptops, and monitors based on 51

environmental criteria developed through

an extensive stakeholder consensus process

supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the

design of products, and provides an opportunity

for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet

ENERGY STAR's energy efficiency specifications,

means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

»  EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

» EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

e EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

*  EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

»  EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

* 2006/95/EC (Low Voltage Directive).

»  2004/108/EC (EMC Directive).

* 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

* 15S09241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

»  GS EK1-2000:2009 (GS mark requirement).
*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-Il (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

e TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO:
Swedish Confederation of Professional
Employees) for TCO versions.



6. Thong tin quy dinh

Energy Star Declaration

(www.energystar.gov)

h As an ENERGY STAR® Partner, we
have determined that this product
retf meets the ENERGY STAR®
guidelines for energy efficiency.

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission
(FCC) Notice (U.S. Only)

€ This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.

22

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la
Communication (FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont congues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteun.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

Toutes modifications n'ayant pas recu
I'approbation des services compétents

en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic
Only)

This dswice belongs to category B devices as described in EN 55022, unless it is specifi-
cally stated that it ia a Class A devics on the specilication labsl. The following applies to
devices in Class A of EN 55022 (radius of protection up to 30 metars). The ussr of the
davics i obliged to take all stapa necessary o remove sources of interfsrence io tela-
communication or other devicas.

Fokud neni na typovém Stitku po&itate uvedeno, 28 spadé dodo tfidy A podie EN 55022,
spadd automaticky do thidy B podie EN 55022, Pro zafizen! zafazend do tidy A (chranné
pésma 30m) podie EN B5022 plati nasledujicl. Dojde-li k rulen! telekomunikadnich nebo
Jinjch zafizeni je utivatal povinnen provést takovd opatfgnl, eby neeni odstranil,

Polish Center for Testing and
Certification Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1T-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji

Unzadseni powinno by zaslane  gnigads # ey acaanym obwodm ochronnyn (gndazdo 7
Kalkien pllpracugaee 2i sobg urzadzenta (komguter, monitor, druksarka) povinky byé zsilane

Instalacja elektrycna pomiesscsenia powinna
przedd swarciami, w pastaci bezpsecentkn
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RHAZHERERZIEE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schédden durch Rontgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber; der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
llla 5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf]
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.
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China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.

hEAFEROHS

RIEFEAR (RFRE-SEREFEENE (EHAFEKRRROHS) -
PAFEA5IH T ARl S &G B E S NRNT RO SRS B

FREALTR
5 (RRRCRT)

ARARYRSATR
HBHAER AEARYRXTH
@ = R A EWEE | SR_EE
(Pb) | (Ha) | (Cd) [ (Crb+) (PBB) (PBDE)
$hEE [¢] [0] [¢] [¢] [¢] [e]
CRIBTR X [e] (o] o] s} o]
BRBTRATE X [e] [¢] (] Q ]
RHIGAH x [0] [0 o [e] [e]
AREES | x [¢] [¢] [e] [€) [e]
RS | x [¢] [¢] [o] [¢] [0]
* I * ARE B EARRN  EREE
O RTHA A BN A SRS B
AT RS A E AR e} MERRRERAT
X ¢ A A TR O RN R b R R
{BFER? k) MEREREER | BRERT X7 W
HARARHSHIER (KT HRLs:)
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RIBREAM (ERNETAEENE FETHFSUTER
>1.05
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PR %15 RIEE N R EHEBHFIAK ¢ http://www energylabel.gov.cn/
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. Dich vu cham séc khach hang va bao hanh

7. Dich vu cham séc
khach hang va bao
hanh

7.1 Chinh sach 16i diém anh

man hinh phang cua Philips
Philips c6 géng cung cap cac san pham
chat Iucyng cao nhat. Chung t6i ap dung
moét sb quy trinh san xuét tién tién nhat
trong [inh vire va thwe hién quy trinh kiém
tra chét Iucyng nghiém ngat Tuy nhién,
céac |6i diém anh hay diém anh con trén
man hinh TFT dung trong cac man hinh
phang doi khi khong the tranh khai. Khong
nha san xuét nao cé thé dam bao rang
moi man hinh s& khong c6 cac 16i diém
anh, nhung Philips dam bao rang béat ky
man hinh nao c6 mét s6 16i khong thé
chap nhéan sé dwoc stra chira hodc thay
mé&i dwa vao chinh sach bao hanh. Thong
bao nay giai thich nhirng kiéu 16i diém anh
khac nhau va dinh nghla cac muc 16i co
thé chap nhan cho méi kiéu 16i. D& hwéng
dich vu stra chiva hay thay thé theo chinh
sach bao hanh, sb lvong 16i didm anh trén
man hinh TFT phai vwot qua cac mirc
chép nhan nay. Vi du, khéng qua 0,0004%
diém anh con trén man hinh cé thé bj 16i.
Ngoai ra, Philips tham con dat ra cac tiéu
chuan chat lwong cao hon cho mét s6
kiéu hay két hop 16i diém &nh vén dé nhin
thay hon céc kiéu 16i khac. Chinh sach
nay co hiéu luc trén toan cau.

diém diém diém
anh phu anh phu anh phu

RGBEY
dlem

Diém anh va diém anh con

Diém anh hay phan t& 4nh gém ba diém
anh con trong cac mau chinh dd, luc va
lam. Nhiéu diém &nh cling tao thanh hinh
anh. Khi moi diém anh con ctia mot diém
anh sang Ien ba diém anh con c6 mau
sac cling hién thi nhw moét dlem anh trang
don 1&. Khi moi diém anh con tbi me, ba

diém anh con c6 mau sac cung hién thi
nhw mgt didm anh den don 1. Nhung két
hop diém &nh con sang va téi khac hién
thi nhw cac diém anh don 1 tir nhitng
mau khac.

Cac kiéu 16i diém anh

Cac 16i diém anh va diém anh con hién

thi trén man h|nh theo nhung cach khac
nhau. C6 hai kiéu I6i dlem anhva nhiéu 16i
diém anh con trong méi kiéu I6i.

Cac 16i cham sang

Cac 16i chdm sang hién thi dwgi dang cac
diém anh hay diém anh con vén ludn sang
hay “bat”. Nghla la m0| cham sang la mot
diém anh con vén ndi 1&n trén man hinh
khi man hinh hién thij kiéu hinh t6i m&. C6
cac kidu 16i chdm sang.

(€

Mét diém anh con sang dd, luc hay lam.

¢

Hai diém anh con sang gan nhau:
Do + Lam =Tim
Dod + Luc = Vang
Luc + Lam = Luc lam (Lam nhat)

Ba diém anh con sang gan nhau (mot
diém anh tréng).
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& Ghi cha

Cham sang d6 hay lam phai sang hon
50% so v&i cac chAm xung quanh trong
khi chdm sang luc sang hon 30% so voi
cac chdm xung quanh.

Cac 16i cham den

Céc I18i cham den hién thj dwdi dang cac
diém anh hay diém anh con vén luén téi
mo hay “tat”. Nghta la mdi cham t6i me
la mot diém anh con vén ndi 1én trén man
hinh khi man hinh hién thi kiéu hinh sang.
C6 cac kiéu 16i cham den.

LOI CHAM SANG

D6 gan cua cac 16i diém anh

Vi céc I6i diém &nh va diém anh con cia
cung kieu I6i von gan v&i moét kieu 16i khac
c6 thé dé& nhin thay hon, Philips ciing néu
ré cac dung sai vé d6 gan cula l6i diém anh.

Dung sai 16i diém anh

D& huéng dich vu stra chira hay thay

thé do cac 16i diém anh trong thoi han

bdo hanh, man hinh TFT trong man hinh
phang Philips phai c6 cac 16i diém anh hay
diém &nh con vuot qué nhivng dung sai
néu trong cac bang sau.

MUC CHAP NHAN

1 diém anh con sang 3
2 diém anh con sang gan nhau 1
3 diém anh con sang gan nhau (m6t diém anh trang) 0
Khodng cach gitra hai I6i chAm sang* >15mm
Tbng sb 16i cham sang ctia moi kiéu 16i 3

LOI CHAM BEN
1 diém anh con t6i mo

MUC CHAP NHAN
5 hoac it hon

2 diém anh con t6i m& gan nhau 2 ho&c it hon
3 diém anh con t6i m& gan nhau 0
Khodng cach gitva hai I6i chAm den* >15mm
Tbng sb 16i chadm den ctia moi kiéu 6i 5 hoac it hon

TONG SO LOI CHAM

Tbng sb 16i chAm sang hay den ctia moi kiéu i

MUC CHAP NHAN
5 hoac it hon

& Ghi chu

1. 1 hay 2 16i diém &nh con gan nhau = 1 16i chdm

2. Man hinh nay tuan thd chuan 1S09241-307. (1IS09241-307: Yéu cau, phan tich vé& hiéu
nang va cac phwong phap kiém tra tuan tha cho man hinh dién tc)
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7.2 Cham séc khach hang & Ché dé bao hanh

D& c6 théng tin chi tiét vé chinh sach bdo hanh va yéu cau hé tro thém dwoc ap dung cho
khu vye cia ban, vui long truy cap website www.philips.com/support. Ban cling c6 thé lién
hé v&i Trung tdm cham soéc khach hang dia phwong cla Philips theo so6 dién thoai dwéi

day.

Théng tin lién lac cho khu vwc TAY AU:

QQuocC gia 0 O a 0

Germany Siemens 1&S +49 01803 386 853 €0.09

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10

Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0.09

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0.08
Netherlands E Care +31 0900 0400 063 €0.10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €0.07
Belgium E Care +32 078 250851 €0.06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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ang va bao han
Théng tin lién lac cho khu viec TRUNG VA DONG AU:

A 0 1d O

(QUOoC gia q 3 0 3 O a ang
Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV” Ltd. +371 7460399
Lithuania NA UAB “Servicenet” +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
f’ﬂirnbt':nigro NA Kim Tec d.o.o. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
Ul NA Comel +380 562320045
NA Topaz-Service Company |+38 044 245 73 31
Russia NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. |NA Asupport 800 100 697
NA Serware +36 1 2426331
Hungary - :
NA Profi Service +36 1 814 8080

Théng tin lién lac cho khu viec CHAU MY LATINH:
Trung tam dich vu

Quéc gia

Brazil

Argentina

Vermont

S6 cham séc khach hang
0800-7254101

0800 3330 856

Théng tin lién lac & Trung Quéc:

Trung Quéc

Sbé cham soc khach hang: 4008 800 008

Thoéng tin lién lac cho khu viec NAM MY:

(Quo QI3 O Z 0 a ang
U.S.A. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696
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Théng tin lién lac cho khu virc Chau A TBD/Trung Bong/Chau Phi (APMEA):

Quéc gia

Trung tam

dich vu

ASC (Trung tam dich vu
ay quyén)

S6 chim séc khach hang

(warranty buy-out)

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / NA Smart Pixels Technology Hong Kong:Tel: +852 2619 9639
Macau Ltd. Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
Indonesia NA PT. Gadingsari elektronika | Tel: 62 21 75909053, 75909056,
Prima 7511530
South Korea |NA PCS One Korea Ltd. 080-600-6600
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics
Singapore NA Singapore Pte Ltd (Philips | (65) 6882 3999
Consumer Care Center)
PCCW
Taiwan Teleservices |FETEC.CO 0800-231-099
Taiwan
Thailand | NA t\t’gs Computer System Co., | 5601 934-5498
South Africa | NA E’tﬂ"ara Technologies Pty | 556 0000 888
Uaned Arab NA AL SHAHD COMPUTER 00971 4 2276525
Emirates LL.C
Israel NA Eastronics LTD 1-800-567000
: ; +84 8 38248007 Ho Chi Minh City
Vietnam NA EErTnS:r:VIﬁ d'"f°"“at'° +84 5113.562666 Danang City
pREEE: +84 5113.562666 Can tho Province
I . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d!stributor and/or service
provider currently
Distributor: Computer
880-2-9141747, 9127592
Bangladesh |NA i:)tl;rce Ltd (warranty buy- 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) 855-023-999992
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8. Khic phuc sw c6 & Hoéi Dap

8. Khac phuc sw co &
Hoi Pap

8.1 Khac phuc sw cb

Trang nay giai quyét cac su c6 vén nguoi
dung co thé khac phuc. Néu sy cb van
tiép dién sau khi ban da th&r dung cac giai
phap trén trang nay, hay lién hé véi dai
dién dich vu khach hang ctia Philips.

H cac swcd thwong gip

Khéng cé hinh anh (Pén LED nguén

khong sang)

Dam bao da cdm day nguon vao 6
cam dién va mat sau cla man hinh.

+  Trudc tién, dadm bao nit ngudn &
mat trwdc man r]inh nam & vi tri OFF
(TAT), sau dé day nut sang vi tri ON
(BAT).

Khéng c6 hinh anh (Bén LED nguén

sang trang)

+  Dam bdo da bat may tinh.

«  DPam bao cap tin hiéu da dwoc két ndi
dlng céach véi may tinh cta ban.

+ Dam bao cap man hinh khéng c6 cac
ch,éu cam bj cong trén mat két noi.
Néu co, hay stra hay thay méi céap.

« C6 thé da bat tinh nang Tiét kiém
nang lvong

Man hinh thong bao

Attention

Check cable connection

+Dam bdo cap man hinh da duoc két
noi dung cach voi may tinh cia ban.
(Cting tham khao Hwéng dan khaoi
dong nhanh).

. Kiém tra xem cap man hinh c6 cac
chau cam bj cong hay khéng.

*  Dam bao da bat may tinh.
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Nut AUTO (Tw dong) khong hoat dong

« Chtrc nang tw ddng chi ap dung & ché
dd VGA- Analog. Néu khong hai long
voi két qua, ban co thé thue hién cac
diéu chinh thd cdng qua menu OSD
(hién thj trén man hinh).

& Ghi chu
Chtrc nang Auto (Tw dong) khong ap dung
& ché d6 DVI-KTS vi n6 khong can thiét.

Cac dau hiéu vé khéi hay tia Itra c6 thé

nh|n thay
Khong thire hién bt ky bwdc khac
phuc sw cb nao

+ Ngat ngay két ndi man hinh khéi 6
cam dién chinh cho an toan

* Lién hé ngay vé&i dai dién dich vu
khach hang cta Philips.

B cac swcé hinh anh

Hinh anh khéng ndm giira tim man

hinh

«  Chinh vj tri hinh &nh qua chirc nang
“Auto (Tw dong)” trong cac nut didu
khién chinh trén menu OSD.

e Chinh vi tri hinh anh qua Phase/Clock
(Géc pha/bdng hd) clia Setup (Cai
dat) trong cac nuat diéu khién chinh
trén menu OSD. N6 chi co6 hiéu lvc &
ché do VGA.

Hinh anh rung Ién trén man hinh

+  Kiém tra xem cap tin hiéu da dwoc
cam chét dung cach vao bang mach
dd hoa hay may tinh hay chua.

Hién thi hién twong chap chon doc

*  Chinh hinh anh qua chtrc nang “Auto
(Tw dong)” trong cac nat didu khién
chinh cia menu OSD.

» Loai bé cac vach doc qua Phase/
Clock (Géc pha/Bdng hd) clia Setup
(Cai dat) trong cac nat diéu khién
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chinh cﬂg menu OSD. N6 chi ¢cé hiéu
lwc & ché do VGA.

Hién thi hién twong chap chén ngang

e Chinh hinh anh qua chirc nang “Auto
(Tw dong)” trong cac nuat didu khién
chinh ctia menu OSD.

» Loai bé céac vach doc qua Phase/
Clock (Goc pha/béng hd) ctia Setup
(Cai d&t) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi co6 hiéu
lwc & ché dd VGA.

Hinh anh hién thj nhoe, khéng ré hodc

qua mo

* Chinh d6 twong phan va do sang trén
menu Hién thi trén man hinh (OSD).

Hién twong “anh ao”, “anh thir nong”
hay “anh béng ma” van hién thj sau khi
da tat nguén.

« Hién thi lién tuc cac anh tinh trong mot
thoi gian dai co thé gay ra hién twong
“anh thir néng”, con dwoc goi la “anh
ao” hay “anh béong ma”, trén man hinh
ctia ban. “Anh th& néng”, “Anh 30
hay “Anh béng ma” Ia hién twong phd
bién trong cong nghé man hinh LCD.
Trong hau hét cac trudng hop, hién
twong “anh th&r nong” hoac “anh ao”
hay “anh béng ma” sé& dan dan bién
mat sau moét thdi gian man hinh bi
ngét dién.

e Ludn béat trinh bdo vé man hinh chuyén
dong khi ban khong str dung man hinh.

* Ludn bat rng dung lam m&i man hinh
dinh ky, néu khéng, man hinh LCD
cta ban sé& hién thj nhirng noi dung
tinh khong thay dbi.

» Cac hién twong “anh thir néng” hay
“anh ao” hay “anh béng ma” sé khéng
biét mat va ban cadn mang man hinh
di stva. Thiét hai nhw trén khéng ndm
trong chinh sach bao hanh cta ching
toi.
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Hinh hién thj bién dang. Van ban bi m¢&

hodc nhoe.

« Cai do phan gidi man hinh may tinh
sang cling ché do véi do phan giai
man hinh gbc khuyén dung ctia man
hinh LCD.

Cac cham luc, d6, lam, den va trang

hién thj trén man hinh

« Cac cham con lai la dc tinh thong
thwong cia man hinh tinh thé 16ng
dung trong cdng nghé ngay nay. Vui
long tham khao chinh sach diém anh
dé biét thém thong tin.

DPén “bat ngudn” qua sang va gay choi

mét

« Ban c6 thé chinh dén “bat ngudn” qua
Cai dat dén LED nguén trong cac nut
diéu khién chinh ctia menu OSD.

Dé duoc tro gitp thém, hay xem danh
sach Trung tdm thong tin khach hang
va lién hé va&i dai dién dich vu cham séc
khach hang ctia Philips.

8.2 Hoi dap SmartControl Lite

H1. Téi da déi man hinh trén PC sang
man hinh khac va khéng thé st
dung SmartControl, t6i can lam
gi?
Hay khé&i dong lai PC va kiém tra
xem SmartControl Lite c6 hoat dong
khong. Néu khong, ban can phai g&
bo va cai dat lai SmartControl Lite dé
dam bao cai dat driver thich hop.
Cac chirc nang SmartControl Lite
da hoat dong tét trwéc dé, nhwng
gi® n6 khéng hoat dong niva, toi
c6 thé lam gi?
Néu da thyc hién cac thao tac sau,
thi ban can phai cai dat lai driver
man hinh.
«  Pa dbi bd thich rng db hoa video
sang moét adapter khac
. Da cép nhat driver video

. Cac hoat dong trén HPH nhw goi
hoac loat (rng dung

bap:

H2.

Dap:



H3.

bap:

H4.

bap:

Chay Cap nhat Windows va cap
nhat man hinh va/hoac driver video
D4 khéi dong Windows bang nut tt
hay ngét két néi man hinh.

Dé& xac dinh sy cb, hay click chudt
phai My Computer (May tinh cua toi)
va click vao Properties (Thudc tinh)
->Hardware (Phan cirng) -> Device
Manager (Quan ly thiét bj).

Néu nhin thay “Plug and Play
Monitor” (Man hinh c&m vao la chay)
hién thj trong Monitor (Man hinh), thi
ban can cai dat lai. Chi can g& bd
SmartControl Lite va cai dat lai.

Sau khi cai dat SmartControl Lite,
khi click vao thé SmartControl
Lite, khong c6 muc nao bat Ién
sau mét lat hoac théng bao 16i
hién thi, diéu gi da xay ra?

Co6 thé Ia do bd thich trng db hoa cua
ban khdng twong thich véi ('ng dung
SmartControl Lite. Néu b thich rng
dd hoa 1a mét trong sb cac nguyén
nhan néu trén, thir tai vé driver

bd thich (rng dd hoa ma&i nhat t
website clia cac cong ty twong rng.
Cai dat driver. G6 bé SmartControl
Lite va cai dat lai mét 1an niva.

Néu né van khéng hoat déng, thi

rét tiéc 1a bd twong ng dd hoa
khéng dwoc hd tro. Vui ldng truy cap
website ctia Philips va kiém tra xem
driver SmartControl Lite méi nhat da
c6 sén hay chua.

Khi t6i click vao Product
Information (Théng tin san pham),
né chi hién thi mét phan, diéu gi
da xay ra?

Co6 thé Ia do driver bd thich (rng db
hoa clia ban khong phai la phién
ban cap nhat mai nhat vén hé tro
day da giao dién DDC/CI. Hay thir
tai vé& driver bo thich rng dd hoa
m&i nhat tlr website clia cac cong
ty twong (rng. Cai dat driver. G6 bd
SmartControl Lite va cai dat lai mét
1&n nira.
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Attention

Theft mode enabled

H5. Toi da quén ma PIN cho chirc nang

bap:

Theft Deterrence (Chéng trém). T6i
can lam gi?

Trung tam dich vu Philips c6 quyén
yéu cau xac nhan va quyén hop lé
dé thiét 1ap quyén s& hivu man hinh.
Xin lwu y chire ndng chéng trom
dwoc cung cap nhu 13 tuy chon tién
ich mién phi. Quan Iy ma PIN la
trach nhiém riéng cda ngwoi dung
ca nhan hay tb chtrc vén da tao ra
ma nay. Trong trvd'ng hop quén ma
PIN, trung tam dich vu Philips c6 thé
tao lai cho ban v&i mirc phi nhé sau
khi xac nhan quyén sé& hiru cia ban.
Xin lwu y chirc nang nay khong dwoc
bao gébm trong cac diéu khoan bao
hanh chinh thirc.

8.3 Hoi bap chung

H1:

bap:

Khi cai cai dat man hinh, t6i can
l1am gi néu man hinh hién thj
“Cannot display this video mode”
(Khdng thé hién thj ché dé video
nay)?

Do phan giai khuyén dung cho man
hinh nay la: 1440 x 900 @60 Hz.
Ngat tAt ca cac cap roi két néi PC véi
man hinh ma ban da dung trwéc dé.
Trong Windows Start Menu (Menu
kh&i dong Windows), chon Settings/
Control Panel (Cai dat/bang diéu
khi&n). Trong Control Panel Window
(Ctra sb bang diéu khién), chon biéu
twong Display (Man hinh). Bén trong
Display Control Panel (Bang diéu
khién man hinh), chon thé “Settings”
(Cai dat). Trong thé cai dat, trong 6
co tén “desktop area (vung man hinh
nén)”, chuyén thanh trwot sang mic
1440 x 900 pixels.



8. Khic phuc sw c6 & Héi Dap

* M& thé “Advanced Properties” (Thudc
tinh nang cao) va cai Mirc cap nhat
(Refresh Rate) sang 60Hz rdi click
OK.

* Khé&i dong lai may tinh va Iap lai bwéc
2 va 3 dé kiém tra xem PC clia ban da
dwoc cai sang mirc 1440 x 900 @60
Hz hay chua.

« Tt may tinh, ngét két ndi man hinh
cii va két ndi lai man hinh LCD Philips
cua ban.

+  Tat man hinh rdi bat lai PC.

H2:

bap:

H3:

bap:

H4:

bap:

H5:

Mcrc cap nhat khuyén dung cho
man hinh LCD la bao nhiéu?

Murc cap nhat khuyén dung cho man
hinh LCD la 60Hz. Néu c6 bét cw
hién twong nhiéu ndo trén man hinh,
ban c6 thé cai dat mirc ndy sang
75Hz dé kiém tra xem mirc méi nay
c6 loai bd dugc hién twong nhiéu
hay khoéng.

Cac file .inf va .icm trén dia CD

1a gi? Lam thé nao dé cai dit cac
driver (.inf va .icm)?

Day la cac file driver cho man hinh
cla ban. Thwc hién theo cac chi dan
trong s6 tay st dung dé cai dat cac
driver nay. May tinh c6 thé yéu cau
ban cai cac driver man hinh (file .inf
va .icm) hoac I4p dia driver khi ban
cai d&t man hinh 1an dau. Thyc hién
theo cac chi dan dé 1&p (dia CD kém
theo) thung dwng man hinh nay. Cac
driver man hinh (file .inf va .icm) sé
dwoc cai dat ty dong.

Lam thé nao dé chinh do phan giai?
Card video/driver dd hoa clia ban
va man hinh s& ciing quyét dinh
cac do phan gidi c6 san. Ban c6 thé
chon dé phan giai mong muén trong
Control Panel (Bang diéu khién)
clia Windows® qua thé “Display
properties” (Thuéc tinh man hinh).
Diéu gi sé xay ra néu téi quén cac
thao tac tiép theo khi dang diéu
chinh man hinh qua menu OSD?

bap:

He6:

bap:

H7:

bap:

H8:

bap:
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Chi can nhan nut OK [E“)i chon
“Reset” (Cai dat Iai) dé phuc hoi moi
cai dat mac dinh goc.

Man hinh LCD c6 kha nang chéng
tray xwéc?

N&i chung ban khéng nén dé bé mét
man hinh va cham qua muc véi cac
vat khac hay va bdo vé nd khoi cac
vat dung sac hay cun. Khi cAm man
hinh, d@m bao khong dung strc ép
hay lwc manh 1&n phia b& mat man
hinh. Biéu nay c6 thé anh hwéng
dén cac diéu kién bao hanh cta ban.

T6i nén lau man hinh LCD nhw thé
nao?
Dé lau thong thuong, hay st dung
khan sach va mém. Dé lau ky, hay
duing con isopropyl. Khéng diing
cac dung méi khac nhw cén étylic,
ethanol, axeton, hexan, v.v...
Tbi c6 thé thay dbi cai dat mau
sac cho man hinh?
D7 nhién, ban c6 thé thay déi cai
d&t mau sac qua nut didu khién trén
menu OSD theo cac quy trinh sau,
Nhén “OK” dé hién thj menu OSD
(Hién thi trén man hinh)
Nhan “Down Arrow” (Mi tén
xudng) dé chon tly chon “Color”
(Mau) rdi nhan “OK” dé vao cai dat
mau; c6 ba lwa chon mau nhuw sau.
Nhiét d6 mau; Hai cai dat gém
6500K va 9300K. Véi cac cai dat
trong pham vi 6500K, man hinh sé
hién thi “néng” v&i tin hiéu dé-trang,
trong khi nhiét d6 9300K tao ra “tin
hiéu mat lam-trdng”.
DPé-Luc-Lam chuan; day 14 cai dat
chuén dé& dam bao trao déi mau
thich hop gitra cac thiét bi khac
nhau (vd: may anh KTS, man hinh,
may in, may quét, v.v...)
Tw chon; ngwdi ding co thé ty
chon cai d&t mau séc wu tién bang
céach chinh mau dd, luc va lam.



8. Khac phuc sw cd & Héi Dap

& Ghichu

Do mau anh sang téa ra tw mcht, vat dung
trong khi né dwgc lam nong. SO do nay

dwoc thé hién dwa trén ty 18 tuyét déi, (mirc

dd Kelvin). Cac mire nhiét dé Kevin thap
hon nhw 2004K la mau dé; cac mirc nhiét
do cao hon nhw 9300K la mau lam. Nhiét
dé trung tinh 1a mau trdng & mirc 6504K.

H9: Tbi c6 thé két n6i man hinh LCD
vé&i moi PC, may chi hay may
Mac?

DPap: C6 thé. TAt ca cac man hinh LCD
Philips d&u hoan toan twong thich
v&i cac PC, may Mac va may chl
chuan. Ban c6 thé can cé dau noi
cap dé két ndi man hinh méi hé

thdng may Mac. Vui long lién hé véi
nhan vién kinh doanh ctia Philips dé

biét thém théng tin.

H10: Man hinh LCD Philips cé hé tr¢
chuan Cam vao la phat?

Pap: C6, cac man hinh Philips déu hd tro

chuén Plug-and-Play twong thich
v&i Windows 7/Vista/XP/NT, Mac
OSX, Linux

H11: Anh chap ch&n hay anh thir néng

hay anh ao hay anh béng ma trén
man hinh LCD la gi?

DPap: Hién thj lién tuc cac anh tinh trong
mot thoi gian dai ¢é thé gay ra hién
twong “anh ther néng”, con dwgc
goi la “anh ao” hay “anh béong ma”,
trén man hinh cta ban. “Anh tho
néng”, “Anh a0” hay “Anh béng ma”
la hién twong phd bién trong cong
nghé man hinh LCD. Trong moi
trwdng hop, hién twgng “anh thr
néng” hay “anh 40” hay “anh béng
ma” sé& bién mét dan trong mét thoi
gian sau khi da t4t nguén.

Ludn bat trinh bao vé man hinh
chuyén déng khi ban khéng st
dung man hinh.

Ludn bat irng dung lam m&i man
hinh dinh ky, néu khéng, man hinh
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LCD cua ban sé hién thi nhiing noi
dung tinh khéng thay doi.

@ canh bao

Cac hién twong “anh thir nong” hay “anh
40” hay “anh bong ma” sé& khong biét méat
va ban can mang man hinh di stra. Thiét
hai nhw trén khéng ndm trong chinh sach
bao hanh cuda chung toi.

H12: Tai sao man hinh cta téi hién thj
van ban sac nét va cac ky tw ring
cwa?

Dap: Man hinh LCD clia ban hoat déng
tbt nhat & do phan giai gbc 1440 x
900 @ 60 Hz. P& man hinh hién thi
tbt nhét, vui long st dung d6 phan
giadi nay.



PHILIPS

A
%

2011 © Koninklijke Philips Electronics N.V. Bao lwu moi ban quyén.
Philips va Philips Shield Emblem la nhirng thuong hiéu da dang ky cua
Koninklijke Philips Electronics N.V. va dwoc st dung dwdi giay phép clia
Koninklijke Philips Electronics N.V.

Cac théng sb k¥ thuat ludn dwoc thay ddi ma khong can théng bao trudc.

Phién ban: M3190E1T



